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Windows Movie Maker Introduction and Tutorial

Windows Movie Maker is free video-editing software
included with Microsoft Windows XP. With Movie Maker,
you can turn footage from your digital video camera into
movies, share them on the Internet, and burn them to CD or
DVD. Downloadable movies from online sources such as
Unitedstreaming can also be edited using this software.

Meeting the Maryland Teacher & Student Technology S  tandards

The state of Maryland recently drafted and passed technology standards for students
and teachers. For detailed information regarding the standards, you can view the
teacher standards (http://www.mttsonline.org/standards/) online or get a printable copy
(http://www.mttsonline.org/standards/MDTchrTechStdsMTTS.pdf) of the standards and

indicators. Here is a link for the student technology standards
(http://www.mcps.k12.md.us/departments/techlit/).

» Maryland Teacher Technology Standards:
o Standard 2- Communication:

= A. Use technology effectively and appropriately to interact

electronically.

» B. Use technology to communicate information in a variety of

formats.

o Standard 3- Legal, Social and Ethical Issues: Demonstrate an
understanding of the legal, social and ethical issues related to

technology use.

o Standard 4- Assessment for Administration and Instruction: Use

technology to analyze problems and develop data-driven solutions for

instructional and school improvement.

o Standard 5- Integrating Technology into the Curriculum and Instruction:

Design, implement and assess learning experiences that incorporate
use of technology in a curriculum-related instructional activity to support
understanding, inquiry, problem solving, communication and/or

collaboration.

0 Standard 6- Assistive Technology: Understand human, equity and
developmental issues surrounding the use of assistive technology to
enhance student learning performance and apply that understanding to

practice.

o Standard 7- Professional Growth: Develop professional practices that
support continual learning and professional growth in technology.

* Maryland Technology Literacy Standards for Students
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o Standard 2- Digital Citizenship: Demonstrate an understanding of the
history of technology and its impact on society, and practice ethical,
legal, and responsible use of technology to assure safety.

o Standard 3- Technology for Learning and Collaboration: Use a variety
of technologies for learning and collaboration.

o Standard 4- Technology for Communication and Expression: Use
technology to communicate information and express ideas using
various media formats.

What is Movie Maker, and why would | use it?

Movie Maker is an easy-to-use video editing program that allows teachers to create
and edit video to enhance classroom instruction and assessment. In order to run
Movie Maker you must be using the Windows XP operating system. With the
program you can use footage from a digital video camera to create a movie. The
program can also be used to edit movie clips from United Streaming to better suit
your needs in the classroom. With Movie Maker, you are no longer tied to viewing a
whole video segment from United Streaming. Instead you can trim the segment to
highlight the objective or teaching point. Movie Maker is a powerful tool to use with
students as well. Here is a short list of ideas of how a teacher can utilize Movie
Maker in the classroom:

* Interviews * Commercials

» Theater performances * Debates

» Digital photo slideshow » Demonstrate science experiments

* Video “field trip” tour » Digital storytelling

* “A Day in the Life of...” e Timelines

* Photo essays * Documentaries

* Student news shows * Showcase student work

» Editing United Streaming videos * Book talks

* Tour of school or classroom e Open House or Back to School
introduction

Before we begin...

You will need a video clip that relates to your ins  truction to use with this
tutorial. If you do not have one on your computer, you can use a clip from
United Streaming. Be sure to save the video clip to a place on your computer
where you can find it again easily. A short clip (between 1-2 minutes) will be best
when learning how to use the program. By the end of the tutorial, you will have a
movie that is trimmed and edited to the objective that you want to highlight in your
classroom instruction.
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Using Movie Maker

Let's get started. The program is located in the multimedia folder of the application
launcher. You will see the screen below when you open Movie Maker.
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There are four main sections to the Movie Maker screen. 1: Task Frame; 2:
Collection Frame; 3. Media Preview Pane; 4: Storyboard and Timeline Frame.
Almost all of the tasks on the main toolbar at the top of the screen can also be
accessed using shortcuts found in one of the four frames on the main screen. Here
are some of the most popular tasks under the main toolbar.

File "Edit| View Tools Clip Play Help

* File Menu

o Create a project, open a project, save a project, and capture video from
digital video camera or from your files.

» Edit Menu
o Undo/redo a command, cut, copy, paste, edit title, select all, and clear
timeline.
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View Menu
o View storyboard, view timeline, view status bar, view tasks, view
collections, and zoom in and out.
Tools Menu
o Titles and credits, effects, transitions, narrate timeline, and adjust audio
levels
Clip Menu
0 Add clip to timeline, trim clip, split clip, combine clips, nudge clips right
or left
Play Menu
o Play clip, play timeline, rewind timeline, previous frame, next frame
Help Menu
0 Takes you to the help index within the program and on the web

Create a New Project

The first step is to create a new project. This will create a Windows Movie

Maker file for you to reference.

onkwhE

Launch the Windows Movie Maker program
Choose File > New Project

Choose File > Save Project As

Browse to My Documents / My Videos folder.
Create a new folder and give it name

Give the project a name and click Save.

**Be sure that all of your videos are located in the same folder as your Movie Maker
project before you begin creating your movie. Otherwise your computer may not
know where to find your videos when you open your project for editing at a later time.

1.
2.

Import Video from Your Computer

In the Task Frame under Capture Video , click import video .

The Import File window will appear. Browse to where you saved your video
clip, and select it. *Notice at the bottom of the Import File window, the box is
selected to have Movie Maker “create clips for video files . (see figure
below)

S 3
Files of type: Wideo Files [".avi." mpg.”.mlv.” mp2." mpdv." m »
[#] Create dips For video files *—
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If you were to select this option, Movie Maker will split the video into short segments
SO you can manage the clips easier in the collections frame. However, be aware that
the program does not always split the video clips in between natural pauses, thus
creating more clips than needed. For this tutorial, we will check the box that says
“create clips for video files " so we will have short clips to work with. If you wanted
your video to import as one whole segment, you will need to uncheck this box when
you import the video.

3. Click Import . You will now see your video clips appear in the collections

frame in the middle of your screen.

**Note: You can also import Photostory slideshows into Movie Maker as a video file. Some people
choose to do this so that they have a variety of video transition options. The directions for importing
Photostory slideshows as a video are the same as what is listed above.

Trimming Clips

Now that you have video clips in the collection frame, you might want to trim them.
The clip may be too long for your purposes, or if you imported from a digital video
camera, there may be dead footage at the beginning or end of a scene that you want
to delete. You can trim clips in the collections frame or after they are moved onto
the storyboard . For this tutorial, we will trim your clips before moving them onto the
storyboard.

1. Locate a clip that you want to trim a few seconds off of the beginning or the
ending. Double click the clip in the collections frame . It will play in the
preview pane .

2. When you come to the point where you want to trim, click the pause button on
the player. (If you didn’t stop on the exact second where you want to clip, click
the previous frame button or next frame button to nudge the clip forward or
backward.)

3. Click split clip button to cut the clip into two parts.

& Pauzed 00003 A 0001007

previous frame next frame split clip
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4. You will see two clips appear in the collections frame now. Both clips will have
the same name, but the second part of the clip will have (1) after it.

Mexico Ray Movie 007 Mexico Ray Movie 007 (1)

T,

5. To delete the part that you do not want, click the clip and click delete on your
keyboard.

6. By using this process, you can select the clips in the collections frame and
clean them up by trimming ends or deleting sections you do not want. Now
the clips are ready to be placed on the storyboard.

Combining Clips

When you import video into Movie Maker, the program splits them into separate clips
for easier editing. If there are two clips that make sense to be together for the
purposes of your movie, you can combine them into one clip again.
1. Inthe collections frame , hold down the control key and select the two
clips you want to combine.
2. Select clip from the top menu, and click on combine . The two clips will
now merge into one clip on the collection pane.

Inserting Pictures

Movie Maker can also import pictures, or still images. When a picture is imported
and added to the storyboard, it defaults to playing the image for 5 seconds in your
movie. Because of this, you can easily add a series of pictures to make a slideshow
in Movie Maker. To add pictures:
1. Under the Capture Video heading, select import pictures .
2. Browse to the pictures you want, select them, and click import . They will
now be added to your collections frame .
3. Drag and drop them onto your storyboard to add them to your movie.
They can be used alone or in combination with video clips.

Inserting a PowerPoint Slide as a Picture in Movie Maker

You can also import PowerPoint slides as images in your Movie Maker project. To
do this, you'll need to save your PowerPoint as a .jpg first.
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After you create your PowerPoint slide, go to File - Save as.
2. Type in a name for your slide.
3. Under the section that says “Save as Type ”, pull down the menu and choose
JPG File Interchange Format .
4. Your slide is now a .jpg. Now you can import the PowerPoint slide as a picture
into Movie Maker.
**Please note: once you save your slide as a .jpg, you cannot change the contents
on the slide.

Taking a Still Image from a Movie Clip

Movie Maker has the capability to take a still picture from a video clip that you have
imported.
1. Select avideo clip in the collections frame that you want to use to find a
still picture. Play the clip so you can view it in the preview pane.
2. When the video comes to the image you want to capture, click the pause
button. The video will stop and show a still image.
3. Click the Take Picture button (it looks like a small camera).

Take Picture button

Movie Maker will automatically take you to the Save Picture As window for

you to name your picture and save it in a folder.

4. Once you have saved your picture, it will also be automatically imported
into your Movie Maker collection.

Building a Storyboard and Moving Clips

A storyboard is a sequence of video, image, and audio files that comprise your
movie. We'll add video clips to the storyboard frame first.

1. View a clip of your video by double clicking it in the collections frame . You
will see it play in the preview pane on the right hand side.

2. Choose a clip to begin your movie. Drag and drop the clip from the
collections frame onto the first frame of the storyboard (begin at the left
hand side).

3. Choose 3-4 more clips to include in your movie until you have a sequence that
you like. Add them to the storyboard by dragging them and dropping them
into place.
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4. You can rearrange the order of your clips even after you place them on the
storyboard. Just click on the clip you want to move, and drag it into the new
place on the storyboard . The clips will switch places after you drag and drop
the clip. (Notice how the labels below the clips change to show that you have
moved clips.)

5. You are currently in the storyboard view . This is what it looks like:

il

-__I!:- l_-- E]Shu:uw Timeline ‘——

b Exico

Fay Movie 002 bl exico Hay Mowvie 003

6. You can change to view the timeline by clicking on Show Timeline .

(see

timeline view below.) You can toggle between these views by clicking Show
Timeline and Show Storyboard .

1)
ey

M A % =L () () | T show Storyboard “'

UIEI.EIEI 0: 01, 00 0:00:20.00

Yideo =

Audio/Music

Title Overlay

1: Zoom In: Allows you to see a closer view
of the storyhoard

2: Zoom Out: Allows you to see alarger
view of the storyhoard

3: Rewind timeline

4. Play timeline

5. Storyhoard/Timeline view: button to
toggle hetween hoth

For now, let’s stay in storyboard view.
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Understanding Collections

What is a collection ? A collection refers to a group of video, audio, and pictures that
you have imported into Movie Maker. You can use them multiple times in your movie
once they are in the collection.

The media in Windows Movie Maker projects are only references to the files
that you’'ve imported into the program. When you edit your media in a collection or
on the storyboard/timeline in Windows Movie Maker, you do not modify the original
source video or audio file. Editing the clips in the program only determines how and
when the audio, video, and pictures (as well as the titles, transitions, and effects) are
displayed in that particular project. All media on the storyboard/timeline becomes a
project. Therefore a Windows Movie Maker project file (which has a .mswmm file
name extension) is a file that contains information about what media is used in the
project, as well as how the media is displayed and timed in the movie. It does not
contain your source files. When you save a project, you can then open it later in the
program and make more changes.

Inserting Video Effects

Now that you have trimmed and edited your clips and added them to the storyboard,
you are ready to add video effects such as: blur, ease in/out, fade in/out, grayscale,
film age, speed up/down, slow down, etc.

1. Be sure you are in storyboard view .

2. Look under edit movie in the task frame .

3. Click view video effects . Your choices will appear in the collections frame
in the middle of the screen.

4. Click and drag the effect you want to the clip on the storyboard. The gray
star in the corner of the clip will now be bright blue, signaling you have
added an effect.

5. To delete an effect, right-click the blue star and click “delete effects ”.

Inserting Video Transitions

You can also insert video transitions at the beginning or end of the movie or between
clips. Transitions are similar to slide transitions that you would see in PowerPoint:
bars, checkerboard, box in/out, fade in/out, wipe, etc.
1. Be sure you are in storyboard view .
2. Look under edit movie in the task frame and click on view video
transitions.
3. Click and drag the transition to the space between the clips that you want
to link. You will see the transition icon appear in the white box.
4. To delete a transition, right-click the transition and click delete .

Preview video transitions and video effects by playing your movie in the media
preview pane.
Frederick County Public Schools- Technology Services
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NOTE: If you have two video clips that have narration and you use a video transition
between them, the audio will sometimes overlap . If this happens, you may not
want to include a transition between those clips.

wico Fay Movie 002 MeMco Ray Movie 003
video effect video transition NO video NO video
added added effect transition

Inserting Titles, Credits, and Subtitles

Adding titles and credits gives your movie a more professional look and feel. Use
titles to introduce the movie or provide background information. Credits at the end of

the movie

allow you to list the people who may have been involved in the movie or

give special thanks to someone. You can also add a title during the movie before or
after selected clips. To add a title to the movie:

1.

Look under edit movie in the task frame . Click Make titles or credits
(You will be prompted to select where you want your title to go: beginning
of the movie, at the end of the movie, on selected clips, before selected
clips, or after selected clips.)

Click Title at beginning of movie . A text box will appear with two panes.
The top box is for the main title. The bottom text box is for a subtitle, if you
choose to add one.

In the top text box, type a title that is suitable for your movie. In the
bottom box, type a subtitle .

Click change the title animation to add movement to the title and subtitle.
Choose the animation that you like.

At this time, you also have the option to change the text font and color

by clicking that link under more options . Click the link to see your
choices.

Under this option, you can change the background color on the title slide.
You can alter the font, color, and size of the text as well as its position on
the slide and the transparency level.

When you have finished, click Done — Add to Movie .

You will see your title screen appear on the storyboard , and it will play
when you preview the movie.
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9. To add credits , you follow the same process, except you click Add titles
or credits , and then add credits to the end of the movie

Add Titles to Clips within the Movie

Adding titles to clips within the movie follows the same process as outlined above.
The only difference is that when you click Done — Add Title to my Movie , it will not
appear as a separate clip on the storyboard. Putting a title over a clip is called an
overlay . Overlays can only be viewed in the Timeline and it appears as a separate
line called Title Overlay. (See picture below.)

title slide added

EIEIEILIEIEIEI 0:00:20.00 0:00

ﬁ . Mexico Ray
¥Yideo E -

Tranzition
Audio | Mexico Ra.. —|Me:-:||:l:u Ray Movie 003
Audiousic

Title Ovverlay

|

title averlay added

Adding Music to Your Movie

You can add music or audio to your movie. Keep in mind if your movie has narration
in it already (such as a video you are editing from Unitedstreaming), music can
detract from the film and make the narration harder to hear. However, if you have a
movie without narration, music can add a nice element and set the mood of your film.
To add a sample clip:

1. Under Capture Video, click Import Audio or Music  from the menu.

2. The Import file window will open to your sample music folder. You
should see two choices that come with your computer. (If you had other
music you wanted to use instead, you would navigate the folders to find the
clip at this time.)

3. Click the Beethoven clip. Click Import . It will appear in the collections
frame.

4. Drag and drop the Beethoven clip from the collections frame onto the
timeline where it is labeled Audio/Music . It will appear on the timeline.

Frederick County Public Schools- Technology Services
Instructions and Use- Page 11 of 14



5.

Last modified: 8/8/07

If the music is not at the beginning of the movie, drag the clip to the
beginning of your movie in timeline view. If your music clip is longer than
the movie, you can also drag the music clip shorter to line up with the end
of your movie. This way the music stops when your movie stops.

.00 0:00:90.00 0:00:20.00 0:0C

. MexicoRayl
video O —_ i : ,i ;
Transition |:|
Audio Mexico Fa: | {Mexico Fay Movie 003 _ _
. . M he . c L h o - music clip
Audio;/Music Beethoven's Symphony Mo, 9[5S cherzo]  -eff— added
Title Ovverlay |I|

If the music plays too loud for your clip, you can edit the audio levels by
right-clicking on the music clip on the timeline and selecting volume . Move
the slider on the volume bar higher or lower to adjust the sound levels and
click ok.

Adding Narration to Your Project

You may want to add a narration to your movie, especially if you have video or
pictures without narration to begin with. If you are making a slideshow of still
pictures, adding narration keeps the stories you tell with your pictures. The best time
to add narration to your project is after you have finished adding media to the
storyboard (video, pictures, transitions, effects, titles, and credits). This keeps your
timing on track. *NOTE: You have a choice to either add narration or add a music
track to your video since they both occupy the same track on the timeline view in the

program.

1.

2.
3.

To add narration:

Connect a microphone to your computer if you do not have a built-in
microphone.

On the Tools menu, click narrate timeline .

If you are prompted with the window below, click ok.

& An audio naration can only be added in the timeline
‘!r) view, The view has been switched from the storyboard to
the timeline.

(] Do ot shaw this dialog again

Click the clips on the timeline that you want to narrate. You can narrate
one at a time, or the whole movie at once. If you narrate individual clips,
you can still rearrange the clips and keep your narration.
Speak into the microphone normally. Adjust the input level so the bar is
about ¥2 up when speaking. (see picture below)
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Narrate Timeline
Drag the plavback indicator on the timeline to an g

Steps: Input level
1.

. ™ | i
Done / - |
Show more options nternal ...

Learn more about narrating the timeline

6. Under Narrate Timeline , click Start Narration . Speak normally into the
microphone as the movie plays. When you are finished, click Stop
Narration .

7. Movie Maker saves your narration as a separate file. In the Save
Windows Media File box, type a name for your narration, and click save.

8. Your narration will be added to your video. If you only narrated one clip
and want to continue to narrate clips, repeat the steps above.

Saving Your Movie to Edit Later

You may not finish a movie the first time you work on it. You will need to save it as a
project so you can edit it later.
1. Click File from the menu and select Save Project As .
2. Type a name for your project. Movie Maker will save your file as a
Windows Movie Maker Project (the file extension will be . MSWMM).
3. Open your project at a later time to continue on it.

Saving Your Finished Project _ into a Movie

Now that you have created your movie, it's time to save it as a finished product.
There are several choices for how you can save your movie. We'll cover how to save
your movie to the computer, to CD and to DVD.

To Save to Your Computer:

1. Look under the Task Pane in the Finish Movie area. Select save to my
computer .

2. The Save Movie Wizard appears. Type a name for your movie file in line
#1. Browse to a folder to save your movie in on line #2.

3. Inthe next screen, keep best quality for playback on my computer
selected. Click Next.
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4. The following screen gives you the option to play the movie after saving it.
You may uncheck box if you like.

To Save to CD or DVD:

If you have a CD burner or DVD burner on your computer, you can save your movie
using this option.
1. Insert a CD or DVD recordable into your computer.
2. Look under the Task Pane in the Finish Movie area. Select save to CD
or save to DVD (depending on what you have).
3. The Save Movie Wizard appears. Follow the directions on screen to
create your CD or DVD.

Additional resources

Here are some additional resources you can use to become more proficient with
Movie Maker:

* Microsoft’'s Movie Maker Page:
http://www.microsoft.com/windowsxp/using/moviemaker /create/lstmovi

e.mspx This page contains various tutorials for the program.

* Mighty Coach Tutorial on Movie Maker:
http://www.mightycoach.com/articles/mmz2/index.html

* Atomic Learning Tutorial on Movie Maker
http://movies.atomiclearning.com/k12/moviemaker2

Frederick County Public Schools- Technology Services
Instructions and Use- Page 14 of 14



